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Preface
CATIA - FEM Surface Version 5 product allows you to rapidly generate a finite element model
for complex surface parts. In other words, you will generate associative meshing from complex
surface parts, with advanced control on mesh specifications.

CATIA - FEM Surface provides users with automatic detail simplification without modifying the
reference geometry.

 

 
Using This Guide
More Information



Using This Guide
This book is intended for the user who needs to quickly become familiar with CATIA - FEM
Surface Version 5. The user should be familiar with basic CATIA Version 5 concepts such as
document windows, standard and view toolbars.

To get the most out of this guide, we suggest you start reading and performing the step-by-step
tutorial "Getting Started". This tutorial will show you how to analyze a part from scratch.

The "Basic Tasks" section presents the main capabilities of the product. Each individual task is
carefully defined and explained in detail. 

It may also be a good idea to take a look at the "Workbench Description" section, presenting
the menus and toolbars.

Finally, a "Glossary" has been provided to familiarize you with the terminology used in this
guide. 
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Where to Find More Information
Prior to reading this book, we recommend that you read:

Infrastructure User's guide Version 5
Part Design User's Guide
Conventions chapter

 

 



Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you
recognize and understand important concepts and specifications. The following text
conventions may be used:
       The titles of CATIA documents appear in this manner throughout the text.
       File -> New identifies the commands to be used.

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button, whenever you read

Select (menus, commands, geometry in graphics area, ...)
Click (icons, dialog box buttons, tabs, selection of a location in the document window,
...)
Double-click
Shift-click
Ctrl-click
Check (check boxes)
Drag
Drag and drop (icons onto objects, objects onto objects)

Drag
Move

Right-click (to select contextual menu)

Graphic conventions are denoted as follows:

indicates the estimated time to accomplish a task.

indicates a target of a task.

indicates the prerequisites.

indicates the scenario of a task.

indicates tips



indicates a warning.

indicates information.

indicates the end of a task.

indicates functionalities that are new or enhanced with this Release.
Enhancements can also be identified by a blue-colored background in the left-hand
margin.

 



What's New?
Meshing Methods

New: Meshing Spot Welds
Enhanced: Setting Global Parameters
New: Adding/Removing Constraints (Specifications) (on the geometry)
New: Adding/Removing Constraints (Modifications) (Contextual menu and Undo simplifications)
New: Removing the Geometrical Simplification
New: Removing the Mesh
Enhanced: Re-Meshing a Domain
Enhanced: Mesh Editing
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Getting Started
This tutorial will guide you step-by-step through your first Meshing Tools session, allowing you
to get acquainted with the product. You just need to follow the instructions as you progress.

Before starting this tutorial, you should be familiar with the basic commands common to all
workbenches. 

The main tasks proposed in this section are:
Entering the Workbench

Defining Surface Mesh Type
Setting Constraints/Nodes
Launching Mesh Operation

Analyzing Quality
Editing a Mesh Element
Re-meshing a Domain

 

Altogether, this scenario should take about 15 minutes to complete.

 



Entering the FEM Surface Workbench
This task shows how to open a part and enter the FEM Surface Workbench.

 
1.  Select File -> Open, and select the desired .CATPart file. In this particular case, open

file called Sample01.CATPart document.

This opens a Part Design document containing the selected part. 

 

 
2. Select Start -> Analysis & Simulation -> Advanced Meshing Tools from the menu bar.

The New Analysis Case dialog box is displayed. 
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3. Select an Analysis Case type (Static or Frequency). In this case, select Static

Analysis.

 
Optionally, you can activate the Keep as default starting analysis case switch if you
wish to have Static Analysis Case as default when launching the workbench again.

 
4. Click OK to enter the workbench.

The Analysis1 document (CATAnalysis model and specification tree) now appears:

 

 

 



Defining the Surface Mesh Type
This task shows how to define, on a single surface part, a mesh type and global
parameters.

 
1. Click the Surface Mesher icon  .

2. Select the geometry to be meshed by clicking on the part.

The Global Parameters dialog box appears.
  3. In the Global Parameters dialog box,

define the mesh parameters.

In this example you will:
leave the Element shape to
quadrangle 

set the Mesh size to 5 mm
set the Maximum sag value to
1 mm
set the Min holes sag value to
10 mm
activate the Geometry 
simplifications option
set the Minimum size to 2 mm

 

 

 

 
4. Click the OK switch button in the

Global Parameters dialog box. 

A new Smart Surfacic Mesh feature
is created in the specification tree.



 

 

  



Setting Constraints and Nodes
 

 

This task shows how to define constraints on edge nodes distributions. For this, you
can select edges, vertices (on the geometrical simplification) or curves or points
(using the geometry).

1. Click the Add/remove constraints icon  .

2. Select the edge to be constrained.

This edge is now yellow colored and the Add/Remove constraints dialog box
displays the selected edge.



3. Click OK in the Add/Remove constraints dialog box to end the constraints definition.

At this stage, constraints are stored in the mesh definition.

 
4.  Click the Nodes distributions icon .

5. Select the edge on which the new distribution will be set. This edge is red colored.



6. In the Edit node distribution dialog box that appears, define the parameters of the
new distribution. In this particular case, select the Uniform distribution type and set
the Number of nodes to 10 and click OK.

The nodes are distributed on the selected edge. The node distribution description
now appears in the Node distributions dialog box.



7.

 

 

Click OK in the Node distributions dialog box, to end the distributions definition.

At this stage, distributions are stored in the mesh definition. You can now launch the
mesh operation.

 

  



Launching the Mesh Operation
This task shows how to generate the mesh, now that you defined the global parameters
and the specifications.

 
1. Click the Mesh The Part icon  .

The mesh is generated on the part and a little summary is provided in the Mesh The
Part dialog box.

The visualization is switched to quality mode so that you can visualize the
generated mesh and the quality of each element.

 



2. Click OK in the Mesh The Part dialog box.

You now enter into a kind of sub-workbench with available commands for specifying
and modifying the mesh geometrical simplification.

 

 

  



Analyzing Element Quality
This task shows how to use some basic quality analysis functionalities. 
Quality Analysis functionalities are available at all steps of the meshing process.

 
1. Click the Quality Analysis icon  .

The Quality Analysis dialog box is a filter that lists the available quality specifications
for visualizing and analyzing the mesh. By selecting particular specifications, you can
decide how you want to view the mesh. It also provides a set of functionalities for
deeper analysis.

 

Quality Specifications of All the Elements
 



2. Click the Report icon  in the Quality Analysis dialog box.
The Quality Report dialog box presents the statistics corresponding to the selected
quality specifications: Good, Poor, Bad Worst and Average.

3. Select the Mesh tab page if you want to view mesh composition statistics (Number of
nodes, Number of element, Connectivity, Number of element per connectivity).

 

 



4. Click OK in the Quality Report dialog box.

Quality Specification of One Element
 

5. Click the Single Analysis icon  in the Quality Analysis dialog box.

6. Select an element in the meshed part. 

The Analyze Single dialog box now appears which gives you a detailed view of the
quality of this element: Taper, Distorsion, Warp Factor, Warp Angle, Skew Angle, Min.
Length, Max. Length, Length Ratio and Normalized Value. In other words, you will
check whether any of your specifications was not properly implemented. 



 
7.

 

Click OK in the Analyze Single dialog box.

 
8. Click OK in the Quality Analysis dialog box to exit the Quality Analysis environment.

 

 

  



Mesh Editing
This task shows how to edit one mesh element by moving one node using auto smooth
options and then cutting one element into two.

 
1.  Click the Edit Mesh icon .

The Mesh Editing Options dialog box appears.

 
2.  Select a node and move it to the desired location.

The quality/visualization of the elements is updated according to the location you
assign to the node.

 

 

 

3.  Check the Smooth around modifications option from the Modify options dialog box.
4. Select a node and move it to the desired location.

The quality of the elements is not modified whatever the location you assign to the
node.



 

5.  Position the cursor over one quadrangle element.

You can now cut the mesh element diagonally according to the position of the cursor.

 

6. Once you have cut one mesh element, position the
cursor over the segment you just created and if you
want to delete this segment, click on it using the
rubber that appears.

 
Note that as the Smooth around modifications option is still active in the Modify
options dialog box, the quality of the elements is not modified whatever the
modifications you perform.

 

 



Re-meshing a Domain
This task demonstrates how to re-mesh a domain by modifying pre-defined local
specifications such as mesh method and size.

 
1. Click the Re-mesh A Domain icon .

The Re-Mesh Domains dialog box appears.

 
2. Select the domain to be re-meshed. As shown in the picture, the selected domain

appears as limited in the red color.



We will try to remove the triangles by locally altering the mesh method.

 
3. Set the parameters for the selected domain from the Re-Mesh Domains  dialog

box.

To do this, you  specify the:
Mesh method
Mesh size
Impact neighbor domains

For this example, we will specify Mapped quads (or quadrangles) and a size of 5
mm. And we let these domain specifications affect neighbor domains.

 
4. Click OK in the Re-Mesh Domains dialog box to re-mesh the domain. The mesh is

updated.

The selected domain is now meshed with quadrangles only.



 
Now that you have completed the tutorial, you can exit the meshing environment.
For this:

5. Click the Exit icon .

The final meshed part can now be
visualized and appears as shown here.

 

 



Basic Tasks
This section describes the basic tasks that allow you to complete the mesh of a part using
CATIA - FEM Surface. 

These tasks include:
Before You Begin
Meshing Methods
Quality Analysis
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Before You Begin
 

You should be familiar with the following basic methodological approach and concepts:

Smart Surface Triangle Quadrangle Mesher
 

The Smart Surface Triangle Quadrangle Mesher works as shown here: you will open the geometry ,

launch the geometrical simplification  and then launch the meshing .

 

 : Open the geometrical element on which you are going to generate geometrical simplification from

parameters. 

 : The geometry is simplified in order to launch the meshing and manage constraints more easily. The level

of the simplification depends on the mesh parameters previously defined.

 : The surface mesh is created from the geometrical simplification previously generated. 

 

 



 

We Advise that...
Please, follow the below described methodological approach when using the CATIA - FEM Surface Version 5
product (Advanced Meshing Tools workbench).
Consider that the CATIA - FEM Surface Version 5 product was developed so that Meshing operation may be as
user friendly and as automatic as possible.

 
If you want your constraints to be associative with the resulting mesh,  before you launch the Mesh
operation apply as many constraints as possible and as automatically as possible. 
Still, try to regularly check how constraints result on the mesh.

 
  Generally speaking, you will start defining parameters, cleaning the geometry according to the desired resulting
meshing and specifying constraints as soon as possible. You will then launch the Geometrical Simplification and in
one go the Mesh operation.

 
 

define parameters1.  
clean the geometry2.  
specify constraints3.  
launch the Geometrical Simplification4.  
launch the Mesh operation5.  
perform constraints modification according to the resulting mesh
elements (not according to the topology)

6.  

if needed, edit the mesh elements7.  

 

 
 

 



 

1. Define Parameters

  From the very beginning, you need to specify global parameters: the shape of the elements, the size of
the elements, the sag and the minimum size of these elements.

 
  Before you define size parameters: After you defined size parameter:
 

   
Use automatic algorithm and only define what the algorithm will not do properly for given cases.

   

 

  2. Clean the Geometry

 

From the very beginning, you will also specify whether or not, you need given holes, button hole gaps (or
cracks) and small faces to be taken into account  by the Geometrical Simplification and therefore by the
Mesher.

 
  Before you clean the geometry: After you cleaned the geometry:

 

   
This must be performed BEFORE you launch the mesh operation. Once the part is meshed, the clean
characteristics can no more be modified.

 

 

 

 

 



3. Specify Constraints

 

You will also specify the constraints that are absolutely necessary for performing the Analysis
computation. For example, you will impose the desired constraints in order to generate connections
between meshes and to create boundary conditions such as restraints and loads.

 
  Before you specify constraints: After you specified constraints:

 

   
Specify as many constraints BEFORE you launch the mesh operation: these constraints will be
associative. Specify these constraints as automatically as possible and avoid modifying them manually
(for example dragging a node).

 
 

 

  4. Simplify the Geometry

 

The Geometrical Simplification computation is based on the global parameters and the constraints
imposed by the user. The system will create an additional set of new constraints that will automatically
help the mesher in creating elements of a higher quality.

Avoid applying too many modifications before simplifying the geometry: launch the Geometrical
Simplification and before modifying manually, check how the resulting mesh looks like.

 
 

 



  5. Launch the Mesh Operation

 

As soon as the mesh elements are generated, a feedback on the quality is provided. You can then
perform manual modifications on the mesh elements, if needed.

BE CAREFUL: this operation can be reversed. Even though you launch the mesh operation, you can
apply modifications to the specifications. First have a look at the domains that seem to be problematic.
Add more or delete existing constraints instead of modifying the mesh elements manually.

  6. Modify the Meshing (or Re-Meshing)

 

Although the algorithms were developed in order to minimize user interactions, after the Mesh operation
was performed, you can still modify the generated mesh elements. In other words, you can:

modify the geometrical simplification generated by the system
modify the nodes distribution 
apply local re-meshing (for example, the size or the type of the mesh elements)
edit mesh elements and apply manual modifications.



Make sure you cannot remove the mesh and modify the constraints specifications instead. These
modifications will not be associative.

 
 

 

  For Advanced Users...

 

If you are an advanced user and know very well how the Mesher behaves,  you can launch the
geometrical simplification, perform the above mentioned re-meshing modifications and then launch the
mesh operation in order to fill the gaps.

 
Make sure you cannot remove the mesh and modify the constraints specifications instead. These
modifications will not be associative.

 

 

 

Colors Used for Elements

Open the sample05.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surfacic triangle quadrangle mesher. 
For this, double-click Smart Surfacic Mesh.1 feature from the specification tree (below Nodes and
Elements feature) and then click OK (Continue anyway?) in the warning box. 
Mesh the surface.
For this, click the Mesh The Part icon . 

 
 
Colors Used for Elements (Quality Visualization Mode)

  Color  Meaning

Green

   

 Used when the element will be solved by the solver without any problem.
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Yellow

   

 Used when the element will be solved by the solver with very few possible problems.

Red

   

 Used when the element will be hardly properly solved.

 

 

Colors Used for Edges and Vertices

Open the sample05.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surfacic triangle quadrangle mesher. 
For this, double-click Smart Surfacic Mesh.1 feature from the specification tree (below Nodes and
Elements feature) and then click OK (Continue anyway?) in the warning box. 
Mesh the surface.
For this, click the Mesh The Part icon . 

 
 
Colors Used for Edges and Vertices

  Color  Meaning

Green

   

Used for free edges and vertices, as well as holes.
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Yellow

 

Used for edges/vertices that are shared between two constrained faces.

Blue

 

Used for edges/vertices that are shared between two non-constrained faces.

Red

 

Used for edges/vertices that are shared between more than two constrained faces.

 

 



Meshing Methods
Surface Mesher
Smart surface triangle/quadrangle Mesher:

Mesh the Surface Part: use smart surface triangle, quadrangle mesher.

Offset the Mesh: apply an offset to a mesh.

Export the Mesh: save the mesh into a bulk data file or CATIA V4 file.
Meshing Spot Welds: mesh spot welds that were previously defined in the Analysis
Connections workbench.

 

Parameters
Prior to mesh operations, you can define meshing parameters (Specification Tools
toolbar):

Set Global Meshing Parameters: setting global meshing parameters: mesh method, size
and so forth.

 

Specifications
You can define specifications that will allow you meshing as desired  (Specification
Tools toolbar):

Remove Holes: ignore holes in the geometry.

Remove Button Hole Gaps: configure the mesher so that it ignores button hole gaps.

Remove Faces: configure the mesher so that it ignores faces.
Add/Remove Constraints Automatically: add or remove constraints applied to vertices or
curves.
Distribute Nodes Automatically: distribute nodes on edges.

 

Automatic Meshing
Once specifications are defined, you can launch automatic meshing:

Mesh the part: use smart surface triangle, quadrangle mesher.



Re-mesh domains: re-mesh a domain using new parameters.

 

Removing Operations
After you launched the geometrical simplification and mesh operations, you can undo
these operations:

Remove the Geometrical Simplification: remove the geometrical simplification you applied
to geometry.
Remove the Mesh: remove the mesh you generated on the geometry.

 

Modifying the Specifications
After you launched the mesh operation, you can manually modify the pre-defined
specifications (Modification Tools toolbar):

Add/Remove Constraints (Modifications): add/remove two types of constraints:
constraints applied to vertices ; constraints applied to curves.

Impose Nodes (Modifications): distribute nodes on edges.

Re-mesh domains: re-mesh a domain using new parameters.

Edit the mesh: edit a mesh to provide higher quality.
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Meshing the Surface Part
FEM Surface lets you automatically handle the mesh of complex geometries with advanced
control on specifications. The meshes are fully associative with design changes. You can define
specifications in order to simplify the geometry. However, the referenced geometry is never
modified in the whole meshing process. The mesh deals with the exact replica of the geometry
as a clone: it respects all the geometry characteristics, and adapt those to the mesh needs,
without impacting the original geometry design. You get an automatic simplified interpretation of
the meshed geometry. For example, you can mesh over holes and gaps. In the same way, it is
possible to eliminate small faces such as stiffeners, flanges for meshing. You can achieve an
accurate and smart elimination of details such as fillets. Different types of finite elements and
meshing methods are available : quadrangles and triangles or advanced front and mapped
meshers.

 
This task demonstrates how to mesh a part.

 
Open the sample08.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree (below
Nodes and Elements feature) and then click YES (Continue anyway?) in the warning
box.  

The constraints and nodes appear. 
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1.  Click the Mesh The Part icon  from the Specification Tools toolbar.

The mesh is generated on the part.

A little summary is provided in the Mesh The Part dialog box.

 
2.   Click OK in the Mesh The Part dialog box.

 
Any modification you will then manually apply to the meshed surface will not be saved for
example if you edit the mesh. In other words, each time you will apply manual modifications
(Add/Remove Constraints Manually, Distribute Nodes Manually, Re-mesh domains, Edit the
mesh), these modifications will only be saved on the condition you launch the mesh operation
again.

 



Offsetting the Mesh 
This task shows how to apply an offset to a 2D mesh (surface element).

 
Open the sample05.CATAnalysis document from the samples directory. 

 
1.  Click the Mesh Offset icon  .

The Mesh Offset dialog box appears.
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2.  Select the mesh.

The Offset field in the Mesh Offset dialog box allows you defining which offset you
want to apply relatively to a given normal. To modify the direction of the normal, click
on it. As a result, the Offset value can only be a positive value.

3. Enter the Offset value in the Mesh Offset dialog box. In this example, enter 5mm and
click OK.

The mesh is now offset relatively to its previous position:



Exporting the Mesh
This task shows how to store a mesh into a new directory and with a new format.

Open the Sample11.CATAnalysis document from the samples directory.

1.  Click the Export Mesh icon .

The Save mesh as dialog box appears.
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2.  Enter the desired options in the dialog box: File name and Save as type.

The mesh is now exported as New_name.dat in the samples directory.

 

 

  



 Meshing Spot Welds
This task shows how to mesh spot welds that were previously defined in the Analysis
Connections workbench.
Open the Sample17.CATAnalysis document from the samples directory.

1.

 
Click the Spot Weld Mesher icon .

The Spot Welding Meshing dialog box appears.
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2.  Select the Spot Welding Analysis Connection object from the specification tree.

Ten welds are selected. The dialog box is updated.

 
3.  Click OK in the Spot Welding Meshing dialog box.

The mesh is updated and the spot welds are meshed too.



 

 

  



Setting Global Meshing Parameters
This task shows you how to define Meshing parameters before actually meshing the
part. 
Open the sample06.CATAnalysis document from the samples directory. 

1.  Click the Mesh The Part icon  .

2.  Select the geometry to be meshed by clicking on the part.

3.  In the Mesh Parameters dialog box that appears, define the desired parameters, if
needed.
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Element shape: it can be either triangle  or quadrangle  method.

Mesh size value: global size assigned to the mesh.
Maximum sag value: the maximum measure of how closely the element
boundaries follow the geometry they are supposed to represent.
Offset value: value according to which both the geometrical simplification and
meshing will be offset.
Min holes size: sets the diameter for automatic hole deletion.
Strip optimization option: allows optimizing the position of the nodes in tight
zones in order to improve the quality of the elements.
Geometry simplifications option: allows managing geometrical constraints that
are too close to each others and generate elements that are too small (the
system performs them). 
Minimum size
More switch button: provides default values for angles between faces and
angles between curves.

Angle between faces: angle computed between the two normals corresponding
to neighbor faces.
Angle between curves: angle computed between two tangents on a contour.
Strip optimization: optimization the nodes position along the strips

 



4.  Click OK in the Mesh Parameters dialog box once you are satisfied with the
parameters. The geometrical simplification is now launched. 

A new Smart Surfacic Mesh entity is created in the tree.

 
You can access and modify these parameters at any time as you perform Mesh Part
operations.
For this, click the Set Global Meshing Parameters  icon to display the Mesh

Parameters dialog box.

 

 

  



Removing Holes
This task shows you how to ignore holes in the geometry which you consider as
unnecessary holes.

 
Open the Sample03.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree
(below Nodes and Elements feature) and then click YES (Continue anyway?) in
the warning box. 

 
1.  Click the Boundary Simplifications icon  from the Specification Tools toolbar .

The Boundary Simplifications dialog box appears:
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Browse: browse the remaining holes 
Auto Focus: zoom in given holes.
Diameter: display the diameter of the currently displayed hole.

The diameter parameter is used to ignore all holes that are smaller than the given
value.

The Undo command is not available.

2. Set the diameter value to 10 mm click Apply.

See how the ignored holes are turned blue.

3. Click a green hole.
It is turned blue and will then be ignored by the mesher.

4. Click a blue hole.
It is reactivated and will be taken into account by the mesher.



The Boundary Simplifications dialog box is updated in accordance with the hole(s) you
selected or de-selected:

 



5.  Click the Mesh the part icon  .

The meshed part now appears with ignored and non-ignored holes.

 

 

  



Removing Cracks
This task shows how to configure the mesher to ignore cracks. These cracks can be
either internal or external to the part.
Open the Analysis2.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree
(below Nodes and Elements feature) and then click YES (Continue anyway?) in
the warning box. 
Mesh the surface.
For this, click the Mesh The Part icon  from the Specification Tools toolbar.

.

You will then click OK in the Mesh The Part dialog box.
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Cracks are automatically detected by the program and are displayed in magenta on
the part.

 

 
1.  Click the Boundary Simplifications icon  from the Specification Tools toolbar.

 
2.  Select the crack to be ignored.

These cracks can be either internal or external to the part. For an internal crack, you
will select an edge, for an external crack, you will select a vertex. 

 



The Boundary Simplifications dialog box displays the selected edge.

 
3.  Click OK in the Boundary Simplifications dialog box.

Now, the crack will be ignored when you will launch the mesher.

In fact, the facing edges of the crack will be merged and the result will be considered
as a standard edge.

 
The Undo command is not available.

 

  



Removing Faces
This task shows how to configure the mesher to ignore faces.

Open the Sample04.CATPart document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree
(below Nodes and Elements feature) and then click YES (Continue anyway?) in
the warning box.  
Mesh the surface.
For this, click the Mesh The Part icon  from the Specification Tools toolbar.

.

You will then click OK in the Mesh The part dialog box. 

 
1.  Click the Boundary Simplifications icon  from the Specification Tools toolbar .

The Clean Holes dialog box appears. You can configure the mesher to ignore faces
and holes by simply clicking on these faces and holes.

 
The Undo command is not available.
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2.  Select the Faces tab in the Clean Holes dialog box and then the faces to be removed
from the model.

The selected faces automatically appear in the Clean Holes dialog box.

 



3.  If needed, select the Holes tab in the Clean Holes dialog box and then the hole to be
removed from the model.

The selected hole automatically appears in the Clean Holes dialog box.

Now, the faces and holes will be ignored by the mesher.

 



4. Click OK in the Clean Holes dialog box.

 
  You can now launch the Mesh operation. For this, click the Mesh the part icon  .

 

 

  



Adding/Removing Constraints (Specifications)
This task shows how to add/remove constraints as mesh specifications either using the geometry
(curves or point) or directly on the geometrical simplification (edges or vertices).

There are two types of constraints.
a constraint applied to a vertex/point: as a result, a node will be created on this vertex.
a constraint applied to a edge/curve: as a result, all the element edges will be aligned on this
curve.

... On/From The Geometrical Simplification

 
Open the sample05.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree (below Nodes and
Elements feature) and then click YES (Continue anyway?) in the warning box. 
Launch the Geometrical Simplification.
For this, click the Run Geometrical Simplification Initialization icon  from the Specification

Tools toolbar.

 
1.  Select the Add/Remove constrains icon  from the Specification Tools toolbar.

 
The Add/Remove Constraints dialog box appears with tabs that will allow you assigning constraints
to edges, vertices / curves, points.
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The Undo command is not available.

2.  Select the edge which you want to constrain.

 
The Add/Remove Constraints dialog box now displays information on the element just selected.



 
3.  Select the vertex which you want to constrain.

The dialog box now displays information on the element just selected.

If you select one element in this dialog box switch buttons become selectable:



Remove: you can remove one constraint you previously created using this dialog box.
Remove All: you can remove all the constraints you previously created using this dialog box.
Zoom: you can zoom in on the constraint that is currently selected in this dialog box.

 
... On/From The Geometry

 
Open the sample18.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree (below Nodes
and Elements feature) and then click YES (Continue anyway?) in the warning box. 

 
1.  Select the Add/Remove constrains icon  from the Specification Tools toolbar.

 

 

The Add/Remove Constraints dialog box appears with tabs that will allow you assigning constraints
to edges, vertices / curves, points.
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  2.  Select the Curve tab in the Add/Remove Constraints dialog box and the desired geometry on the
CATAnalysis document.

The  dialog box now displays information on the elements just selected.

  3.  Select more geometry (the points) on the CATAnalysis document.



The dialog box is now as shown here:

 
  4. 

 

Click OK in the Add/Remove Constraints dialog box.

 



  5.  Mesh the surface.
For this, click the Mesh The Part icon  from the Specification Tools toolbar.

.

You will then click OK in the Mesh The part dialog box. 

The part is meshed accordingly.

 

  



Distributing Nodes (Specifications)
This task shows how to distribute nodes (as mesh specifications) either on free edges or
on constrained edges.

 
Open the sample07.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree
(below Nodes and Elements feature) and then click YES (Continue anyway?) in
the warning box. 

 
1.  Click the Nodes distribution icon   from the Specification Tools toolbar .

The Node Distributions dialog box appears. This dialog box will display information on
the nodes you are going to distribute.

The Undo command is not available.
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2. Select the geometry on which you want to distribute nodes.

The Edit Node Distribution dialog box now appears with given default values.

Uniform/None
Number of nodes: check this option to define the number of the nodes you
want to distribute on the currently selected geometry.
Size: check this option to define the size on which a given nodes will be
uniformly distributed.

 
3. If needed, modify the number of the nodes. In this case, enter 3 as new value.

 



4. Click OK in the Edit Node Distribution dialog box

The nodes appear on the geometry.

The Node Distributions dialog box is automatically updated.

If you select one element in this dialog box switch buttons become selectable:
Edit: you can display the Edit Node Distribution dialog box and, if needed,
modify the values.
Remove: you can remove one node distribution you previously created using
this dialog box.
Remove All: you can remove all the node distributions you previously created
using this dialog box.



Zoom: you can zoom in on the node distribution that is currently selected in this
dialog box.

 
5. Click OK in the Node Distributions dialog box once you are satisfied with you

operations.

 

  



 Removing the Geometrical
Simplification

This task shows how to remove the geometrical simplification you applied to geometry.

Open the sample08.CATAnalysis document from the samples directory.

Before You Begin:
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree
(below Nodes and Elements feature) and then click YES (Continue anyway?) in
the warning box. 
Launch the geometrical simplification.
For this, click the Run Geometrical Simplification Initialization icon  from the

Specification Tools toolbar.
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1.  Click the Remove Geometrical Simplification icon   from the Modification Tools

toolbar.

The geometrical simplification is automatically removed.

 

The mesh elements also are removed.

 

  



 Removing the Mesh
This task shows how to remove the mesh you generated on the geometry.

Open the sample08.CATAnalysis document from the samples directory.

Before You Begin:
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree
(below Nodes and Elements feature) and then click YES (Continue anyway?) in
the warning box. 
Launch the Geometrical Simplification.
For this, click the Run Geometrical Simplification Initialization icon  from the

Specification Tools toolbar.

Mesh the surface.
For this, click the Mesh The Part icon  from the Specification Tools toolbar.

.

You will then click OK in the Mesh The part dialog box. 
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1.  Click the Remove Mesh icon   from the Modification Tools toolbar.

The mesh is automatically removed.

 

 

  



Adding/Removing Constraints (Modifications)
This task shows how to apply Manual topological modifications on existing constraints. There are two
types of constraints.

a constraint applied to a vertex: as a result, a node will be created on this vertex.
a constraint applied to a curve: as a result, all the element edges will be aligned on this curve.

 
Open the sample05.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree (below Nodes
and Elements feature) and then click YES (Continue anyway?) in the warning box. 
Launch the Geometrical Simplification.
For this, click the Run Geometrical Simplification Initialization icon  from the Specification

Tools toolbar.

 
1.  Select the Manual topological modifications icon  from the Modification Tools toolbar .

.

The Edit Options dialog box appears with one option for re-meshing automatically as you modify
the geometrical simplification.

 

The Undo command is not available.

 
2.  Right-click the elements required for modifying edges, vertices or still for performing split,

collapse or merge operations.
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3.  Select the desired options from the available contextual menu.

For edges:

For vertices:

The desired option (contextual menu), once selected, remains active. You then simply need to
select the elements to be modified.

 

Swap constrained state option

If you right-click on this part: You get this constrained state edge:

 

Split a domain option

If you right-click on two existing vertices: You get this split domain:



 

Collapse edge option

  If you right-click on an edge: You get this collapsed-edge element:

 

I

   

Cut edge option

If you right-click on an edge: You get this cut edge (and new vertex):

   



Merge edges option

  If you right-click on two collapsed edges: One after the other:

 

I

 

You get this merged edge:

 
Undo simplifications option

This option can be applied either on simplifications generated by the system or on simplifications you
applied manually (see above).

  If you right-click on an edge: You get this unmerged mesh element:

 

I



Imposing Nodes (Modifications)
This task shows how to impose node distribution on geometry.

Open the sample08.CATAnalysis document from the samples directory.

Before You Begin:
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree
(below Nodes and Elements feature) and then click YES (Continue anyway?) in
the warning box. 
Mesh the surface.
For this, click the Mesh the part icon  from the Specification Tools toolbar.

.

You will then click OK in the Mesh Update dialog box. See Setting Global
Parameters for more information on this step.
Display the geometry in the Shading mode.
For this, click the Shading (SHD) icon from the View toolbar.

 
1.  Click the Imposed Nodes icon   from the Modification Tools toolbar .

The Imposed Nodes dialog box appears. 
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The Undo command is not available.

2. Select the geometry on which you want to modify nodes distribution.

The Edit Node Distribution dialog box now appears with default values corresponding
to the edge you just selected.

 



3. Modify the number of the nodes. In this case, enter 2 as new value.

 
4.

5.

Click OK in the Edit Node Distribution dialog box.

In the Imposed Nodes dialog box, activate the Auto remesh on modification option
and click OK.

The new nodes appear on the geometry which is automatically re-meshed.

 

 

  



Re-Meshing a Domain
This task shows how to re-mesh a domain using new specifications such as mesh
method and size.
Open the sample05.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree
(below Nodes and Elements feature) and then click YES (Continue anyway?) in
the warning box. 
Mesh the surface.
For this, click the Mesh the part icon  from the Specification Tools toolbar.

.

You will then click OK in the Mesh Update dialog box. See Setting Global
Parameters for more information on this step.
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1.  Select the Re-mesh a domain icon  from the Modification Tools toolbar.

The Re-mesh Domains dialog box appears with modifiable options on mesh method
and size.

 
Mesh method: select one of the available types.

 Front quads

 Front trias

 Mapped quads

 Mapped Free quads



 Bead quads

 Half Bead quads

 Projection

 
Mesh size: 
Enter the desired size

 
Impact neighbour domains
Define whether you wish to apply the new mesh method to the neighboring
domains. If the option is de-activated, the nodes on domain edges will not be
modified.

 

 

The Undo command is not available.

 

2.  Select the desired options in the dialog box. For example, Mapped quads.

 



3.  Select the desired domain on the surface.
The edge of selected domains can be either green (constrained) or yellow (free).

The domain is automatically re-meshed:

 

 



Mesh Editing
This task shows how to edit elements. Thanks to the full cursor editing, you can update dynamically the
quality analysis results on the mesh. When quality criteria are respected, you will see the change in finite
element color. You can also move nodes on geometry, edit finite elements (splitting, swapping, and so
forth) or smooth the mesh.

 
Open the sample05.CATAnalysis document from the samples directory.

Before You Begin
Enter the smart surface triangle quadrangle mesher. 
For this, double-click Smart Surface Mesh.1 feature from the specification tree (below Nodes and
Elements feature) and then click YES (Continue anyway?) in the warning box. 
Mesh the surface.
For this, click the Mesh the part icon  from the Specification Tools toolbar.

You will then click OK in the Mesh Update dialog box. See Setting Global Parameters for more
information on this step.

 
1. Click the Edit Mesh icon  from the Modification Tools toolbar.

The Mesh Editing Options dialog box appears.

 
Smooth around modifications: allows optimizing the shape of the element so that split
elements meet desired Analysis criteria:
Note that as the Auto smooth option is inactive in the Modify options dialog box, the
surrounding elements are not modified and therefore do not enhance the quality whatever the
modifications you perform.
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Smooth around modifications option activated (the shape of the neighbor elements is
altered in order to have the best possible quality of the elements)

 
Smooth around modifications option de-activated (the shape of the neighbor elements is
not altered)

   
Combine around modifications: allows combining two triangles into a quadrangle of good
quality (when possible).

 
Combine around modifications option activated 

   



Swap around modifications: allows dragging a node on a surface.

 
Propagate to neighbour domains: allows propagating smoothing modifications from one
domain to a neighboring one.

 
Global Optimization: let's you launch again the Quality Analysis.

 
 

Dynamic update of element quality analysis  (colors change, if needed)

You can split or combine elements:

 
2. Position the cursor over one quadrangle element.

You can now cut the mesh element diagonally according to the position of the cursor.

Before (quadrangle mesh)

After (cut mesh according to the position of the cursor)

     

 



Full mouse mesh editing

You can drag nodes on surfaces

3. Select a node and move it to the desired location.

The quality of the elements updates according to the location you assign to the node.

 
Automatic Smooth on Nodes

You can smooth elements by letting the algorithm update the mesh elements location.

 

 

4. Click on a node.

The node is automatically moved to the optimum location. The quality of the elements updates
according to this new location.

 

 

   
Contextual Menu

 



4. Right-click on one segment and display the contextual menu.

 

: allows removing edges you previously created manually when

splitting a quadrangle element
In this case, we activated all the options, right-clicked an edge and activated the Remove edge
option from the contextual menu.

edge selected

 

deleted edge

 
: allows condensing nodes on edges

In this case, we activated all the options, right-clicked an edge and activated the Condense
nodes option from the contextual menu.

edge selected

 

condensed node

 

: allows inserting a node on an edge

In the case below, we de-activated the Auto combine and Auto swap options, right-clicked an
edge and activated the Insert node option from the contextual menu.



edge selected inserted node

In the case below, we activated the Auto combine options, right-clicked an edge and
activated the Insert node option from the contextual menu.
edge selected inserted node

 

 



Glossary
 

C
crack A geometry defect that occurs when two adjacent faces, near the free edges,

are not topologically linked.

D
domain A sub part on a surface.

G
global size The target size for element edges.

I
interference A standard geometrical intersection.

intersection
A given distance (or clearance) beyond  which the elements generated are
positioned. This let's you take into account the real width of the geometry when
detecting interferences.

M
minimum size The minimum size of an edge of an element. When the detail elimination option

is active, the mesher does not generate elements with edges shorter than the
minimum size.

P
part A 3D entity obtained by combining different features in the Part Design

workbench. Please see CATIA - Part Design User's Guide for further
information.
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